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AutoCAD 2007

В начале проекта, перед глазами разработчиков AutoCAD простирался впечатляющий пейзаж. С одной стороны располагались счастливые пользователи наиболее успешной версии AutoCAD R14, и было ясно, что нужно что-то экстраординарное, чтобы снова привлечь их внимание. С другой стороны располагались циники, разглагольствовавшие о недостатках нечетных версий и поддерживавшие конкурентов Autodesk. Более того, Autodesk сама нуждалась в более сильной и полноценной платформе для воплощения своей стратегии на вертикальных специализированных рынках.
Команда AutoCAD с готовностью приняла вызов. С точки зрения человеко-часов разработчики удвоили свои усилия в сравнении с работой над AutoCAD R14. Это помогло в том, что большинство разработчиков сразу включились в работу, концентрируясь на удовлетворении потребностей клиентов, а не на построении взаимоотношений внутри коллектива. Кроме того, что разработчики расширили сферу интересующих их вопросов, они еще больше углубили свой фокус. Проводя аналогию с автомобильным производством, мы хотели не просто создать надежную машину, мы хотели, чтобы она была стильной, имела плавные формы, и продумана до мельчайших подробностей, вплоть до щелчка дверцы. Мы хотели создать продукт, обладающий тем неуловимым сочетанием мощи и удовольствия, которое так трудно описать, но легко ощутить.
В контексте программного обеспечения САПР, мы хотели, чтобы наши клиенты получили чувство свободы в плане определения целей своего проекта и в то же время чувство единения с программным обеспечением. Эта цель важна в то время, как компании все большее внимание уделяют творческим проектным замыслам (например, компьютеры iMac) для того, чтобы обрести индивидуальность среди себе подобных. Команды проектировщиков нуждаются в программном обеспечении, которое не только позволит им проектировать, но и сотрудничать в коллективе.
В связи с этим разработчики сконцентрировали внимание на 5 ключевых потребностях наших клиентов:
Производительность прежде всего, поскольку каждая минута является решающей в этом конкурентном мире 
Программное обеспечение должно устранять препятствия, облегчая эффективную работу клиентов 
Данные САПР имеют динамический характер, а все полезные наработки должны быть доступны для многократного использования 
Нельзя быть изолированным, а сотрудничество в проектировании должно быть беспрепятственным 
Дизайн - дело личное, а программное обеспечение САПР должно быть адаптируемо к индивидуальным потребностям. 
Их усердный труд явился частью общих усилий Autodesk по разработке целого семейства продуктов для удовлетворения этих потребностей. От платформы AutoCAD нового поколения к свежему набору вертикальных продуктов, нацеленных на удовлетворение специфических потребностей клиентов, к новой линии продуктов для эффективного сотрудничества, Autodesk активно работает с тем, чтобы наши клиенты использовали дизайн как оружие в их конкурентной борьбе. 

Первые успехи!

По мере того, как команда программистов AutoCAD приближалась к завершению разработки, подразделения продаж и маркетинга с энтузиазмом готовили премьеру AutoCAD 2007. Большой бум начался 4 марта очень успешным спутниковым показом в Австралии, а также мероприятиями по всему миру. За неделю с 8 по 12 марта в США и Канаде прошла спутниковая трансляция в 20 городах. Американские реселлеры включились в продвижение продукта, проведя более 1000 семинаров. Неделей позже состоялась европейская премьера на CeBIT в Германии, а кинофильм Design 2007 показывался в кинотеатрах в Великобритании, после чего были проведены сотни семинаров во всем регионе. Специальные мероприятия также проводились в Японии, Сингапуре и Малайзии. Волна мероприятий для поддержки AutoCAD 2007 и продуктов на его основе будет нарастать в ближайшие месяцы по мере выхода локализованных версий и вертикальных решений. 
Мы часто говорим о чувстве гордости и уверенности в "машине" разработки программного обеспечения Autodesk. И они приготовили еще одну звездную версию. Если объединить это с отлично организованными мероприятиями по запуску продукта, то Вы получите мощную формулу успеха.
На самом деле запуск продукта начался еще весной 1998г., когда Autodesk впервые показала продукт избранным партнерам-разработчикам ADN. Мы расширили аудиторию разработчиков на протяжении прошлого года, что ведет к своевременной готовности многих ключевых приложений. В августе мы скоординировали свои планы выпуска продуктов и начали внутреннее обсуждение. К октябрю мы уже показывали избранным аудиториям избранные функциональные возможности новой версии. К тому времени наши региональные маркетинговые подразделения начали разрабатывать свои локальные планы запуска продукта. В декабре мы начали информировать прессу и предоставили ключевым журналистам возможность ознакомиться с продуктом, чтобы они подготовили статью к весенним выпускам журналов. Мы стали пропагандировать новую концепцию Design 2007. К январю были подготовлены основные материалы для обучения дилеров во всем мире. Это обучение дилеров проходит сейчас.

Пять основных задач САПР

Поскольку AutoCAD 2007 обладает более 400 усовершенствованиями, совсем непросто охватить широту и глубину этой версии в простом перечне функций. Скорее, более  уместным, было бы говорить об основных задачах, которые решают эти функции. Вот они:
Производительность прежде всего, поскольку каждая минута является решающей в этом конкурентном мире 
Программное обеспечение должно устранять препятствия, облегчая эффективную работу клиентов 
Данные САПР имеют динамический характер, а все полезные наработки должны быть доступны для многократного использования 
Нельзя быть изолированным, а сотрудничество в проектировании должно быть беспрепятственным 
Дизайн - дело личное, а программное обеспечение САПР должно быть адаптируемо к индивидуальным потребностям. 
В ответ на эти актуальные задачи, функциональные возможности AutoCAD 2007 можно разделить на следующие пять тем: 

Многозадачная среда проектирования

В самом реальном смысле AutoCAD 2007 олицетворяет переход от клавиатурной зависимости к эффективному проектированию, обеспечивая пользователям взаимосвязь с миром разумного автоматизированного дизайна. Следующие три выпуска AutoFact будут посвящены функциям, которые позволяют пользователям концентрироваться на решении проектных задач, а не на клавиатуре. В центре внимания этого выпуска- многозадачная среда проектирования MDE. Пользователи теперь могут работать более разумно и эффективно, чем когда-либо.
Многозадачная среда проектирования Multiple Design Environment (MDE)
Вы наверняка знакомы с термином "многооконный интерфейс"-- Multiple Document Interface (MDI)-который означает возможность открывать множество документов в едином сеансе работы программы. AutoCAD 2007, вооружившись этой концепцией, делает шаг вперед, представляя многозадачную среду проектирования MDE. MDE соответствует стандартам Windows® и предоставляет разумную среду, которая повышает производительность и облегчает применение программы. При помощи MDE, Вы можете перемещаться между чертежами без прерывания рабочего процесса и "соединяться" как со своими собственными данными, так и с данными других пользователей, используя повторно полезные наработки. 
MDE предлагает множество возможностей, включая такие функции высокого уровня, как: 
Открытие нескольких чертежей. AutoCAD 2007 дает Вам возможность открывать множество файлов чертежей в одном сеансе работы AutoCAD. В диалоговом окне File Open, Вы можете выбрать несколько файлов с одновременным нажатием клавиши Shift или Control, а затем нажав кнопку Open. Либо можно открыть несколько чертежей одновременно, перенеся их из Windows Explorer в сеанс работы AutoCAD. 
Перенос и копирование объектов. Эта функция дает возможность копирования или переноса объектов внутри или между чертежами простым переносом их мышью. Перенос чертежа или файла с нажатием правой кнопки мыши из Windows Explorer дает Вам опции открытия, вставки, присоединения внешней ссылки XREF, копирования объекта OLE, или создания гиперссылки к документу, который Вы переносите. Это существенно сокращает число шагов, на выполнение многих операций и немедленно повышает эффективность. 
Поддержка копирования свойств. При помощи простого щелчка мыши Вы можете теперь копировать свойства объектов, такие как: цвет, слой, тип линии, масштаб типа линии, и другие, от одного чертежа к другому. Эта функция улучшает единообразие чертежей и ускоряет завершение чертежей. 
Вырезать/Копировать/Вставить. Эта функция позволяет Вам точно копировать объекты чертежа от одного чертежа в другой внутри одного сеанса работы AutoCAD, сокращая время, затрачиваемое часто на повторное вычерчивание аналогичных объектов. Кроме того, у Вас есть возможность либо задать базовую точку вставки, либо использовать исходные координаты, что не только повышает эффективность, но также обеспечивает точность чертежа. 
Последовательное исполнение команд. Позволяя Вам переключаться между чертежами без отмены текущей команды, последовательное исполнение команд значительно сокращает число прерываний рабочего процесса. 
Внедрение MDE в AutoCAD было непростой задачей, это не просто функция, это рабочая среда и полностью новый способ проектирования. Следите за следующими выпусками бюллетеня и применяйте на практике новые усовершенствования и инструменты
AutoCAD 2007 для повышения Вашей производительности.

Менеджер свойств объектов

Доступность и удобство - это то, что делает программное обеспечение прозрачным для пользователя, проще говоря, пользователь не должен быть экспертом по использованию AutoCAD для того, чтобы использовать программу. Это также то, что позволяет пользователям концентрироваться на их непосредственной работе- проектированию и черчению. Эти вопросы были в зоне повышенного внимания разработчиков AutoCAD.
AutoCAD 2007 продолжает переход от командно-ориентированного интерфейса к проектно-ориентированному, Это один из способов достичь повышения производительности и сделать широко применяемые инструменты более доступными и простыми в применении. Усовершенствования в производительности AutoCAD 2007 предназначены для повышения простоты использования, автоматизируя определенные задачи и делая AutoCAD более интегрированным с Windows. Вот некоторые из этих функций: диалоговое окно свойств объектов Object Properties, усовершенствованные фильтры выбора, и контекстные меню, вызываемые правой кнопкой мыши.

Диалоговое окно свойств объектов

AutoCAD 2007 вводит в обиход диалоговое окно свойств объектов, которое революционизирует способы просмотра и редактирования любых объектных свойств. Диалоговое окно свойств объектов объединяет функциональные возможности таких команд, как DDMODIFY DDEDIT, DDCHPROP, и других, начинающихся с DD..... и добавляет множество других специфических команд редактирования. Через единое диалоговое окно свойств объектов Object Properties, которое можно изменить в размерах, припарковать или спрятать при необходимости, можно модифицировать практически все свойства объектов AutoCAD простым быстрым и наиболее эффективным способом. Единой диалоговое окно с двумя колонками информации заменило собой около 40 различных диалогов и команд, которые прежде каждый пользователь должен был знать, что, очевидно, сильно упростило программное обеспечение и процесс проектирования в AutoCAD. 
Вот некоторые из функциональных возможностей при редактировании свойств объектов в диалоговом окне: 
Редактирование по типу. Эта функция диалогового окна фильтрует наборы выбранных объектов по типу объекта, таким образом давая Вам возможность модифицировать свойства для каждого объекта. 
Редактирование без выбора объектов. Когда нет текущего набора выбранных объектов, то показывается текущее состояние таких свойств чертежа, как гиперссылки, стиль вывода на печать, ПСК и данные о видовых экранах. При этом они доступны для редактирования. 
Закладки диалогового окна. Закладки диалогового окна позволяют увидеть свойства объектов по категориям (например, Общие свойства, Геометрия, и т.д.) или в алфавитном порядке, упрощая поиск специфического свойства. 
Динамическое обновление. Модифицированные свойства обновляются динамически на экране, предоставляя немедленный отклик системы для более точного редактирования свойств. 
При помощи еще одной функции быстрого выбора Quick Select, Вы можете легко отфильтровать наборы выбранных объектов в диалоговое окно свойств объектов для редактирования, при помощи пары щелчков мышью. Это не только великолепная функция для пользователя, она была создана в расчете на разработчиков. Диалоговое окно свойств объектов Object Properties также полностью доступно к расширению независимыми разработчиками; таким образом позволяя всем разработчикам на платформе AutoCAD передавать их специфические объекты и свойства в диалоговое окно для доступа и редактирования конечными пользователями. 

Пользовательский интерфейс AutoCAD

При первом запуске Рабочий стол AutoCAD настроен по умолчанию (рис. 1.4).


В Рабочий стол AutoCAD для Windows включены:
· падающие меню — верхняя строка непосредственно под заголовком окна программы; 
· необязательные панели инструментов: 
· Standard и Styles — вторая строка от заголовка; 
· Layers и Properties — третья строка; 
· Draw и Modify — например, столбцы слева и справа; 
· строка состояния — строка внизу окна программы; 
· окно командных строк — выше строки состояния; 
· необязательное экранное меню — столбец справа; 
· графическое поле, занимающее остальную часть Рабочего стола. 

Падающие меню

Строка падающих меню может быть изменена путем добавления либо удаления тех или иных пунктов. Для этого необходимо выбрать в падающем меню пункты Tools > Customize > Menus..., в появившемся диалоговом окне Menu Customization перейти на вкладку Menu Bar и отметить требуемые пункты. 
Загрузка другого меню AutoCAD производится либо в том же диалоговом окне Menu Customization, на вкладке Menu Groups, либо с помощью команды MENU, введенной в командной строке.
Строка падающих меню по умолчанию содержит следующие пункты:
· File — команды работы с файлами: создание, открытие, сохранение, печать, экспорт файлов в другие форматы и пр.; 
· Edit — инструменты для редактирования частей графического поля Рабочего стола программы, работы с буфером обмена; 
· View — команды управления экраном, панорамирования, установки точки зрения, удаления невидимых линий, закраски, тонирования, управления параметрами дисплея; установка необходимых панелей инструментов; 
· Insert — команды вставки блоков, внешних объектов, объектов других приложений; 
· Format — команды работы со слоями, цветом, типами линий; управления стилем текста, размеров, видом маркера точки, стилем мультилинии; установки единиц измерения, границ чертежа; 
· Tools — средства управления системой, экраном пользователя; установки параметров черчения и привязок с помощью диалоговых окон; работы с пользовательской системой координат; 
· Draw — команды рисования; 
· Dimension — команды простановки размеров и управления параметрами размеров; 
· Modify — команды редактирования элементов чертежа; 
· Window — многооконный режим работы с чертежами; 
· Help — вывод на экран системы гипертекстовых подсказок. 

Панели инструментов

Команды AutoCAD на панелях инструментов представлены в виде пиктограмм. Если задержать указатель мыши на пиктограмме, рядом с ней появляется название соответствующей команды, помещенное в маленький прямоугольник.
Если в правом нижнем углу пиктограммы изображен маленький черный треугольник, это значит, что она содержит подменю с набором родственных команд. Для вызова подменю необходимо на некоторое время задержать на пиктограмме указатель мыши, нажав ее левую кнопку.
Панели инструментов могут быть плавающими (float) или закрепленными (dock) с фиксированным местоположением. Допускаются изменения размеров плавающих панелей, а также их перемещение по графическому полю (рис. 1.5).
Плавающую панель можно сделать закрепленной, перетащив ее мышью за пределы графического поля. И наоборот, как только закрепленная панель попадает в область графического поля, она превращается в плавающую.


Рис. 1.5. Плавающая панель инструментов 

При первой загрузке AutoCAD на экране присутствует шесть панелей инструментов: 
· стандартная — Standard, панель стилей — Styles; 
· панель слоев — Layers, панель свойств — Properties; 
· панели рисования — Draw и редактирования — Modify. 
Вывести на рабочий стол требуемую панель инструментов можно, указав ее имя на вкладке Toolbars диалогового окна Customize — рис. 1.6. Это диалоговое окно загружается из падающего меню View > Toolbars..., или Tools > Customize > Toolbars..., или из пункта Customize... контекстного меню, выводимого на экран нажатием правой кнопки мыши в фоновой области панелей инструментов (рис. 1.7). 
Удобно выбирать имя требующейся панели инструментов из списка контекстного меню (рис. 1.8), которое появляется при нажатии правой кнопки мыши, если ее указатель находится на любой пиктограмме панелей инструментов. Если же указатель мыши находится в фоновой области панелей инструментов, то список панелей инструментов можно получить после выбора пункта ACAD контекстного меню, показанного на рис. 1.7. 


Рис. 1.6. Диалоговое окно выбора панелей инструментов


Рис. 1.7. Контекстное меню выбора панелей инструментов


Рис. 1.8. Список панелей инструментов 
Для удаления панели инструментов необходимо сделать ее плавающей, если она закреплена, и щелкнуть по кнопке закрытия, расположенной в правом верхнем углу заголовка панели. Другой вариант — отключить ее отображение на вкладке Toolbars диалогового окна Customize или в соответствующем контекстном меню. 

Стандартная панель инструментов

Стандартная панель Standard показана на рис. 1.9. Она содержит следующие инструменты: 


Рис. 1.9. Стандартная панель инструментов

Qnew — создание нового файла рисунка;
Open (Ctrl+0) — загрузка существующего файла;
Save (Ctrl+S) — сохранение текущего файла;
Plot (Ctrl+P) — вывод рисунка на плоттер, принтер или в файл;
Print Preview — предварительный просмотр чертежа перед выводом на печать, позволяющий     увидеть размещение чертежа на листе бумаги;
Publish — публикация листов рисунка в формате .dwf;
Cut to Clipboard (Ctrl+X) — копирование объектов в буфер обмена с удалением их из рисунка;
Copy to Clipboard (Ctrl+C) — копирование выбранных элементов чертежа в буфер Windows без  удаления их из исходного документа;
Paste from Clipboard (Ctrl+V) — вставка данных из буфера Windows;
Match Properties — копирование свойств заданного объекта другому объекту;
Undo - отмена последнего действия;
Redo — восстановление только что отмененного действия; 
Pan Realtime — перемещение изображения на текущем видовом экране в режиме реального времени; 
Zoom Realtime — увеличение или уменьшение видимого размера объектов на текущем видовом экране в режиме реального времени; 
Подменю ZoomWindow — раскрывающийся набор инструментов, в котором можно задать различные способы увеличения и уменьшения видимого размера объектов на текущем видовом экране; 
Zoom Previous — возврат к показу предыдущего вида; 
Properties (Ctrl+1) — загрузка палитры управления свойствами объектов; 
DesignCenter (Ctrl+2) — диалоговый интерфейс, позволяющий быстро находить, просматривать, вызывать, переносить в текущий рисунок ранее созданные  рисунки, управлять вхождениями блоков, внешними ссылками и другими элементами рисунков, такими как слои, листы и текстовые стили; 
Tool Palettes (Ctrl+3) — отдельные вкладки в специальном окне, которые служат эффективным средством хранения/вставки блоков и штриховки. Палитры могут содержать инструменты, предоставленные сторонними разработчиками; 
Sheet Set Manager (Ctrl+4) — диспетчер наборов листов, позволяющий организовать размещение пакетов листов в зависимости от типа чертежей и с возможностью эффективного создания, управления и совместного использования наборов логически связанных рисунков; 
Markup Set Manager (Ctrl+7) — диспетчер, позволяющий организовать работу с рисунками формата .dwf; 
Help — вызов справочной системы. 

Панель слоев



Панель слоев Layers, показанная на рис. 1.10, чаще всего размещается на Рабочем столе и обеспечивает работу со слоями. В нее входят следующие инструменты:

Рис. 1.10. Панель слоев 


Layer Properties Manager — вызов диалогового окна установки параметров слоев Layer Properties Manager; 
Filter applied - раскрывающийся список управления слоями. Каждая строка содержит пиктограммы управления свойствами слоя или отображения его свойств, а также его имя. Ниже перечисляются назначения пиктограмм (слева направо): 
· Turn a layer On or Off — включение/отключение слоя; 
· Freeze or thaw in ALL viewports — замораживание/размораживание на всех видовых экранах; 
· Freeze or thaw in current viewport — замораживание/размораживание на текущем видовом экране; 
· Lock or Unlock a layer — блокирование/разблокирование слоя; 
· Color of layer — цвет слоя; 
· имя слоя (в примере Layerl). 
Make Object's Layer Current — установка текущего слоя в соответствии со слоем выбранного примитива; 
Layer Previous — возврат к предыдущему состоянию слоев. 
Панель свойств объектов 
Панель свойств объектов Properties, показанная на рис. 1.11, предназначена для работы с цветом, типом и весом линий. 
В нее входят следующие инструменты: 

Рис. 1.11. Панель свойств объектов 


	Color Control - раскрывающийся список установки текущего цвета, а также изменения цвета выбранных объектов; 

	Linetype Control — раскрывающийся список установки текущего типа линии, а также изменения типа линии для выбранных объектов; 

	Lineweight Control — раскрывающийся список установки текущего веса (толщины) линии, а также изменения толщины линий выбранных объектов; 

Plot Styles Control — раскрывающийся список установки стилей печати. Здесь можно изменять внешний вид вычерчиваемого на плоттере рисунка. В стилях печати при необходимости переопределяются цвета, типы и веса (толщины) линий объектов. Кроме этого, имеется возможность указывать используемые при печати стили концов линий, соединений и заполнений, а также различные выходные эффекты — размывание, оттенки серого, присвоения перьев и интенсивность. Манипулируя стилями печати, можно получить на бумаге различные варианты одного и того же рисунка. Допускается применение стилей печати к объектам или слоям. 

Строка состояния

Строка состояния расположена в нижней части Рабочего стола. Она содержит текущие координаты курсора, а также кнопки включения/выключения режимов черчения (рис. 1.12): 
· SNAP — Snap Mode, включение и выключение шаговой привязки курсора; 
· GRID — Grid Display, включение и выключение отображения сетки; 
· ORTHO — Ortho Mode, включение и выключение ортогонального режима; 
· POLAR — Polar Tracking, включение и выключение режима полярного отслеживания; 
· OSNAP — Object Snap, включение и выключение режимов объектной привязки; 
· OTRACK — Object Snap Tracking, включение и выключение режима отслеживания при объектной привязке; 
· LWT — Show/Hide Lineweight, включение и выключение режима отображения линий в соответствии с весами (толщинами); 
· MODEL/PAPER — Model or Paper space, переключение из пространства модели в пространство листа. 


Рис. 1.12. Строка состояния

Окно командных строк

Окно командных строк обычно расположено над строкой состояния; оно служит для ввода команд и вывода подсказок и сообщений AutoCAD. Размеры окна, а следовательно, количество выводимых строк протокола можно изменять. При наличии в окне команд более одной строки перемещение по строкам осуществляется с помощью полосы прокрутки. 
По умолчанию окно команд закреплено и равно по ширине окну AutoCAD (рис. 1.13). Если текстовая строка не помещается в окне, ее полное содержимое выводится в рамке вблизи командной строки. 


Рис. 1.13. Закрепленное окно командных строк

Изменить высоту окна можно с помощью разделительной полосы, находящейся в его верхней части (если оно закреплено внизу) или в нижней (если оно закреплено вверху). Чтобы изменить размер, следует захватить разделительную полосу мышью и отбуксировать ее до требуемой высоты. 
Окно может быть как закрепленным, так и плавающим. Закрепление отменяется путем выбора рамки окна в любом месте и последующей буксировки за пределы зоны закрепления до тех пор, пока граница окна не примет вид широкой контурной линии. Если отпустить окно в этот момент, оно станет плавающим и приобретет размер, который имело до закрепления. Плавающее окно может быть перемещено в любую позицию экрана; при этом пользователю разрешено изменять его ширину и высоту (рис. 1.14).


Рис. 1.14. Плавающее окно командных строк

Закрепляется окно команд путем буксировки к верхней или нижней зоне закрепления окна AutoCAD. В окне командных строк можно прокручивать текст, выполнять его редактирование и повторно вводить команды. Для этого используются стандартные клавиши: <—, вверх, —>, вниз, Insert, Delete, Home, End, Page Up, Page Down, Backspace. При повторении ранее введенных команд удобно воспользоваться комбинацией клавиш Ctrl+C, чтобы копировать выделенный текст в буфер обмена, и Ctrl+V — чтобы вставить содержимое буфера в текстовое окно или окно команд. При щелчке правой кнопкой мыши в области окна командных строк или текстового окна AutoCAD вызывает контекстное меню, куда входят шесть последних использованных команд, функции копирования выделенного текста или всего протокола команд, вставки текста, а также вызова диалогового окна Options. 

Текстовое окно

Просмотреть большую часть протокола команд — так называемую историю команд (command history) - можно, переключившись в текстовое окно, показанное на рис. 1.15. Оно вызывается по нажатии функциональной клавиши F2 или по команде TEXTSCR, из падающего меню View > Display > Text Window F2.


Рис. 1.15. Текстовое окно
Текстовое окно подобно окну команд: в нем также можно вводить команды, наблюдать подсказки и сообщения, выдаваемые AutoCAD. Для перемещения по окну используются полоса прокрутки или клавиши <—, вверх, —>, вниз, Page Up и пр. Содержимое текстового окна предназначено только для чтения и не подлежит изменению. Но протокол команд можно копировать для последующей вставки в командную строку или текстовый редактор. 

Экранное меню

В AutoCAD 2005 сохраняется возможность отображения экранного меню. Его включение и отключение выполняются на вкладке Display диалогового окна Options, загружаемого из падающего меню Tools > Options.... Достаточно поставить или снять флажок Display screen menu в области Window Elements.
Экранное меню AutoCAD имеет иерархическую структуру. Используя переходы в различные подменю, можно передвигаться по дереву меню. Для перехода к корню дерева служит верхняя строка экранного меню, где всегда находится слово AutoCAD.

Функциональные клавиши

Для удобной работы с системой сохраняется возможность использования функциональных клавиш:
· F1 — вызов справочной системы AutoCAD; 
· F2 — переключение между текстовым и графическим окнами; 
· F3 или Ctrl+F — включение/отключение текущих режимов объектной привязки OSNAP; 
· F4 — переключение системной переменной TABMODE; 
· F5 или Ctrl+E — циклическое переключение изометрических плоскостей; 
· F6 или CtrL+D — включение/отключение отображения текущих координат курсора в строке состояния; 
· F7 или Ctrl+G — включение/отключение отображения сетки GRID; 
· F8 или Ctrl+L — включение/отключение ортогонального режима ORTHO; 
· F9 или Ctrl+B — включение/отключение шаговой привязки SNAP; 
· F10 — включение/отключение режима полярного отслеживания POLAR; 
· F11 — включение/отключение режима объектного отслеживания OTRACK; 
· Esc или Ctrl+[, Ctrl+\ — прерывание текущей операции; 
· Enter, Ctrl+M или Ctrl+J — повторение последней команды; 
· Ctrl+A — включение и отключение выбора группы объектов; 
· Ctrl+C — копирование объектов в буфер обмена Windows; 
· Ctrl+N — открытие диалогового окна создания нового рисунка Create New Drawing; 
· Ctrl+O — открытие диалогового окна выбора ранее созданного чертежа Select File; 
· Ctrl+P — открытие диалогового окна вывода чертежа на печать Plot-Model; 
· Ctrl+R — смена видового журнала; 
· Ctrl+S — сохранение текущего рисунка; 
· Ctrl+V — вставка объектов из буфера обмена данных в текущий чертеж; 
· Ctrl+X — удаление выбранных объектов из чертежа и копирование их в буфер обмена данными; 
· Ctrl+Y — восстановление только что отмененного действия; 
· Ctrl+Z — отмена последней команды. 

Контекстное меню

Для выбора пунктов меню и команд на панели инструментов часто используется устройство указания — мышь. При работе с мышью нажатие левой кнопки обычно обеспечивает выбор и указание точки на экране; щелчок правой кнопкой мыши вызывает контекстное меню (см. рис. 1.7,1.8,1.16). Форма и содержание меню зависят от положения указателя мыши и состояния задачи: например, обеспечивается быстрый доступ к опциям, необходимым для текущей команды.


Рис. 1.16. Пример контекстного меню

При щелчке правой кнопкой мыши в области рисования вызывается одно из шести контекстных меню: 
· стандартное — содержит набор стандартных функций, предназначенных, в частности, для работы с буфером обмена, зумирования, панорамирования. Чтобы вызвать это меню, необходимо отменить выбор объектов, завершить текущую активную команду и щелкнуть правой кнопкой мыши; 
· редактирование — объединяет функции, предназначенные для редактирования объектов. Набор функций может изменяться в зависимости от типа выбранного объекта. Чтобы вызвать меню, необходимо выбрать один или несколько объектов, завершить текущую активную команду и щелкнуть правой кнопкой мыши; 
· команда — содержит набор функций, облегчающих выполнение команд с помощью мыши. Сюда также включаются опции текущей команды, отображаемые в командной строке. Для вызова данного меню необходимо при выполнении какой-либо команды щелкнуть правой кнопкой мыши; 
· объектная привязка — позволяет выбрать или настроить режимы объектной привязки, включить координатный фильтр. Для вызова меню следует щелкнуть правой кнопкой мыши, удерживая нажатой клавишу -Shift; 
· ручки — содержит функции, позволяющие проводить редактирование с помощью ручек. Для вызова меню необходимо выделить на объекте ручки и щелкнуть правой кнопкой мыши; 
· OLE — объединяет функции, позволяющие редактировать OLE-объекты. Для вызова меню необходимо щелкнуть правой кнопкой мыши по вставленному в рисунок OLE-объекту. 
Контекстные меню объектная привязка, ручки и OLE всегда включены, а потому их можно вызывать в любой момент. Контекстные же меню стандартное, редактирование и команда можно отключить. 
В этом случае щелчок правой кнопкой мыши будет соответствовать нажатию клавиши Enter. По умолчанию вызов этих трех контекстных меню включен. 
Для других элементов окна AutoCAD, кроме области рисования, можно вызывать следующие контекстные меню: 
панель инструментов. Для включения/отключения какой-либо панели или для настройки панелей необходимо щелкнуть по любой из них правой кнопкой мыши. Для отображения списка групп 
· панелей следует щелкнуть правой кнопкой мыши по свободной области правее стандартной панели инструментов; 
· командная строка. Для выбора одной из шести команд, выполнявшихся последними, или для вызова некоторых функций, используемых при работе с командной строкой, необходимо щелкнуть правой кнопкой мыши по командной строке или в окне команд; 
· диалоговое окно (это меню доступно не для всех диалоговых окон). Как правило, контекстные меню связаны либо с раскрывающимися списками, либо с полями для ввода значений и позволяют удалять, переименовывать отдельные пункты списка или работать с буфером обмена. Контекстные меню могут быть связаны и с некоторыми другими элементами окон. Для вызова меню следует щелкнуть правой кнопкой мыши по элементу диалогового окна; 
· строка состояния. Для переключения режима рисования или изменения настроек необходимо щелкнуть правой кнопкой мыши по области строки, где выводятся текущие координаты, либо по любой кнопке переключения режима рисования или изменения настроек; 
· вкладки Model/Layout. Для вызова окон печати и настройки параметров страницы, а также управления листами следует щелкнуть правой кнопкой мыши по вкладке Model или одной из вкладок Layout. 
Проектирование Компьютерного стола на AutoCAD 2007
Для построения трехмерного изображения компьютерного стола, я использовал инструмент rectangle (прямоугольник) из панели Draw (Черчение),модификатор extrude (выдавить) из панели Solids, для преобразования прямоугольника в трёхмерное изображение куба. Для построения реалистичного изображения клавиш ноутбука, мы применили инструмент taper faces из панели Solid Editing , а также subtract из панели моделирование, для реалистичного изображения полок компьютерного стола 



МОДЕЛИРОВАНИЕ



ЧЕРЧЕНИЕ



Solid editing



Компьютерный стол в трехмерном пространстве
Вид сверху вид снизу и вид с Юго-Западной изометрии.
 


Объектные гиперссылки

При помщи мощной новой функции Hyperlinks, пользователи могут легко присоединять гиперссылки к объектам AutoCAD, а затем последовательно передавать эту связь любому файлу DWG, файлу документа в Windows, адресу URL, и т.д. где угодно в мире. Диалоговое окно вставки гиперссылок и новая панель инструментов для работы с Web обладают мощными функциями, просты в использовании и согласуются с другими офисными приложениями. 
Характерный курсор дает динамический отклик, когда он наталкивается в чертеже на объект с гиперссылками. Подобно кнопкам навигации вперед и назад в браузере, похожие кнопки на панели инструментов для работы с Web позволяют пермещаться между посещаемыми web-серверами, документами Word, электронными таблицами Excel, чертежами AutoCAD и другими файлами. 

ePlot - электронная печать файлов DWF

Электронная печать -- ePlot, новинка в AutoCAD 2000, дает пользователям все управление, точность и функциональность, которые им необходимы для публикации чертежей в защищенном, нейтральном и готовом к использованию на Internet формате DWF (Drawing Web Format). Благодаря функции ePlot, Вы обладаете точностью печати на бумаге, при этом экономя время и деньги, связанные с распространением бумажных  копий чертежа. Вот некоторые из преимуществ функции ePlot: 
Интерфейс вывода на печать AutoCAD 2007 пользуется для создания файлов DWF, так что пользователи могут по-прежнему контролировать размер листа, отступы, толщину линий, и другие атрибуты печати. 
Сохраненные параметры печати могут быть легко использованы в электронном выводе ePlot в файл DWF, гарантируя тем самым единообразие между файлами DWF и бумажными распечатками. 

Заключение

В заключении хотелось бы сказать, что AutoCAD 2007 обладает более 400 усовершенствованиями, совсем непросто охватить широту и глубину этой версии в простом перечне функций. Скорее, более  уместным, было бы говорить об основных задачах, которые решают эти функции. Вот они:
Производительность прежде всего, поскольку каждая минута является решающей в этом конкурентном мире 
Программное обеспечение должно устранять препятствия, облегчая эффективную работу клиентов 
Данные САПР имеют динамический характер, а все полезные наработки должны быть доступны для многократного использования 
Нельзя быть изолированным, а сотрудничество в проектировании должно быть беспрепятственным 
Дизайн - дело личное, а программное обеспечение САПР должно быть адаптируемо к индивидуальным потребностям. 
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